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Resumen

Este documento proporciona una breve introduccion al proceso de crea, construir y depurar proyectos
basados en eZeeNet, utilizando el software IDE libre Eclipse, el compilador WinAVR y el hardware mkl|
JTAGICE en un PC con Microsoft® Windows™2000/XP.

Este tutorial explica cdmo crear un pequeiio proyecto que controla uno de los LEDs en la placa
de desarrollo MeshBean de MeshNetics y depurarlo mediante Eclipse y el hardware mkll
JTAGICE.

Convenciones utilizadas en el documento

Botones Los nombres de los botones de didlogo son representados en Courier: OK, Cancel
Comandos de Los items son representados en Courier y mostrados en el orden en que deben ser
menu seleccionados: File ->Open

Atajos de Muchos atajos deben ser presionadas simultaneamente en el orden en que se
teclado muestran: F7, Ctrl-Shift-F5

Cédigo fuente Los fragmentos de codigo se muestran en texto coloreado:

/*\k*\k*\k*\k*\k*\k*\k*\k*\k*\k***************************

User's entry.

***********************************************/

void fw userEntry (FW ResetReason t resetReason)

Nombres de Los nombres de archivos y directorios se notan como simples citas: ‘bin’, ‘avr-gdb.exe’
archivos y
directorios

Intencién del documento

Este documento estd dirigido a los desarrolladores que quieran familiarizarse con la creacién de
aplicaciones mediante la pila MeshNetics eZeeNet ZigBee.

Documentos relacionados

[1] ZigBit™ Development Kit. User’s Guide. MeshNetics Doc. S-ZDK-451

[2] JTAGICE mkll Quick Start Guide http://www.atmel.com/dyn/resources/prod _documents/doc2562.pdf

[3] WinAVR User Manual / Ed. by Eric B. Weddington

[4] AVR Studio. User Guide. Available in HTML Help with the product.
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Prerrequisitos

Asegurese de que tiene instalado en su PC la ultima versién de JAVA Run-time Environment (JRE) (puede
descargarlo de http://www.javasoft.com), Eclipse para desarrollos C++ (http://www.eclipse.org ) y EinAVR
(http://winavr.sourceforge.net).

También necesitara una placa MeshBean [1] y un dispositivo Atmel mkll JTAGICE[2].

Debera instalar el controlador USB mkll JTAGICE disponible con el WinAVR [3].

Instalando el controlador mkll JTAGICE

Las siguientes instrucciones son vdlidas para Windows XP

1. Conecte el mkll JTAGICE a su PC, enciéndalo y abra el Administrador de Dispositivos de Windows. Si
no instal6 el controlador proporcionado con AVR Studio, podrd ver un USB Device marca bajo
larama Other devices (verFigural).

=10l x|

File  Action  Wew Help

2 | @ EFES 2 A xRa
i Computer ;I

g Disk drives

g Display adapkers

L, DVDYCD-ROM drives

[y Floppy disk controllers

3 Floppy disk drives

-5 Human Inkzrface Devices
-2 [DE ATAMATAPT contrallers
F-Z5 Kevboards

[y Mice and cther pointing devices
o3

Manitars
[H-EZ Network adapcers
EI--“} Other devices

- Ports (COM &LPT)
=598 Processors
ﬂy Sound, viceo and game corkrolers

[+ i Swstern devices
- Universal serial Bus contrallers |-

Figura 1: Pantalla del Administrador de Dispositivos
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2. Sinoinstald el controlador de Atmel, habrd un item JTAGICE mkII bajola rama Jungo.
Haga click en cualquiera de esos elementos y seleccione Update driver del menu.Enla
siguiente ventana (ver Figura 2), seleccione Install from a list or specific
location (Advanced):

Hardware Update Wizard

Welcome to the Hardware Update

:.l?\ Wizard

Thiz wizard helps you ingt all software for:

JSE Deviee

; '\:I If your hardware came with an installation CD

A

i or Hoppy disk, insert it now.

YWhat do pou want the wizard to do’?

{7 Install the software automatically [Fecommended]

Chek Mest to continue.

< Back I Mext I Cancel

Figura 2: Asistente de actualizacién del hardware, pantalla de comienzo
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3. HagaclickenNext > para continuar. En la siguiente ventana (ver Figura 3), seleccione Don’ t
search. I will choose the driver to installyhagaclickenNext >
para continuar.

Hardware Update Wizard

Please choose your zearch and installation options.

™ Search for the best diiver in these locations.

I1ze the check boxes below ta limit or expand the default search, which includes local
pathz and removable media. The best diver found will be installed.

[T Search removable media (lopey, CO-REH...]

¥ | Include this lacation in the seanch:

IE:"-.Win-‘i'-."v"H Sutilzslibuzbhbin j Browze |

i+ Don't search. | wil choose the driver to install}

Choose thiz option to zelect the device driver from a list. Windows does not guarantee that
the driver you chooze will be the best match for pour hardware,

¢ Back I Mest > I Cancel

Figura 3: Asistente de actualizacion del hardware, opcion de buscar
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4. HagaclickenNext > denuevoy, al aparecer la nueva ventana, click en el boton Have Disk..
(ver Figura 4):

Hardwar e Update Wizard

Celect the device driver you want to install for thiz hardware.

Select the manufacturer and model of your hardware device and then click Mest. [f pou
have a disk that cantains the diver pau wank b install, 2lizk Have Disk.

_rﬂ:::del -
:':?9" CO-ROM Drive [force CODGS accurate)

ﬂED-HDM Drive [force CODA inaccurake
[Standard keyboards) [ ]

[Standard zystem devices) N
LI—I S CO-ROM Drive IMAP zettings 0.1]

A
e -
< I I "‘-."} T DCkd Diciam MTRAAD Ambhicnaes 0700 _I

EgF This driver is digitally signed. Have Disk... |
Tell me swhy driver sighitg iz imporkant

¢ Back I Mest » I Cancel |

Figura 4: Asistente de actualizacién del hardware, pantalla de dispositivos

5. Hagaclicken Browse...,, navegue a la carpeta ‘Utils\Libusb\Bin’ del directorio de instalacién de
WIinAVR, seleccione‘jtagice2.inf y haga click en el botén Open, entonces pulse OK

Creando un nuevo proyecto en Eclipse

1. Inicie el IDE Eclipse ejecutando ‘eclipse.exe’ . Si es la primera vez que utiliza Eclipse, aparecera una
pantalla similar a la de la Figura 5.
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Fle Edit Navigate Search Project Run Window Help
welcome. £3 {ar =8

Figura 5: Pantalla de inicio Eclipse

2. Hagaclick en el botdn mas a la derecha (Go to Workbench) o en el botén X junto a Welcome
en la parte superior de la ventana. Como muchos IDEs modernos, Eclipse tiene un concepto de
workspace — Un espacio comun para varios proyectos, es decir, puede tener un workspace para
desarrollos embebidos y otro para aplicaciones Windows. Un proyecto puede pertenecer a
diferentes workspace. Por defecto, Eclipse crea un nuevo workspace en la carpeta de usuario
Windows (C:\Documents and Settings\... o como se llame en su ordenador). Este no es el mejor
lugar para guardar sus proyectos, porque a las herramientas de WinAVR no les gusta que los nombres
de directorios contengan espaciox. Se recomienda crear un directorio separad para los proyectos
eZeeNet, por ejemplo C:\eZeeNet. Desde ahora se usard este directorio en el tutorial.

3. SeleccioneFile ->Switch workspace ->Other delmenu de aplicacidn de Eclipse e
introduzca “C:\eZeeNet” en el cuadro de texto (El directorio serd creado si no existe). Eclipse se
reiniciara y abrira el nuevo workspace.

4. Seleccione File ->New ->Project.. delmenu, expanda la seccién C de la lista que
aparece, seleccione C Project yhagaclickenelbotéon Next > para continuar. Introduzca el
nombre del proyecto (“DebugTest”) en el cuadro de texto Project name: y haga click en

Finish. Algunas veces se abrira la siguiente ventana:
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& Dpen Associated Perspective? ﬂ

This kind of project is associabed with the C/C++ perspective, Do wou wank
- ko open this perspective now?

[ Remerber my decision

o |

Figura 6: Cuadro de didlogo Abrir Perspectiva Asociada

5. Hagaclicken Yes para continuar

Configurando las herramientas externas

Para usar las prestaciones de programacion/depuracion de mkll en Eclipse, tendremos que configurar las
dos herramientas externas que hay que ejecutar cada vez que se necesite programar el dispositivo con
una nueva imagen y antes de comenzar la sesién de depuracidén. Como WinAVR es un juego de
herramientas en linea de comandos, la programacion del médulo con la imagen construida se realiza
mediante la herramienta en linea de comando ‘avarice.exe’. Tan sélo hay que ajustar un “wrapper” para
esta herramienta, para evitar escribir nada cada vez que se necesita ejecutar.

1. Seleccione Run ->External Tools ->Open External Tools Dialog.. del
menu (ver Figura 5).

2. Hagaclickenelbotéon New launch configuration delabarrade herramientasen la
esquina superior izquierda del cuadro de didlogo External Tools (verFigura7).

3. Introduzca Burn image en el cuadro de texto Name :. Haga click en el boton Browse
File System.. bajoelcuadrodetexto Location:, dirijase al directorio de instalacién de
WinAVR y seleccione el archivo ‘avarice.exe’ (normalmente situado en el subdirectorio ‘bin’ de
WinAVR).

4. Pulse el botén Browse Workspace... bajoel cuadro detexto Working Directory:,
seleccione su proyecto actual (DebugTest) y pulse OK. Note que el cuadro de texto cambia a
“S{workspace_loc:/DebugTest}”, que no es una ruta estandar, sino una variable de entorno (Se
discutira mas adelante).
Escriba “2 —repf DebugTest.elf —j usb” en el cuadro de texto Arguments.
Dirijase a la pestafia Common (ver Figura 8) y marque la casilla External tools enlalista
Display in favourites.

7. Pulse el botén Apply para guardar la nueva configuracion.
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& External Tools

Create, manage, and run configurations

Run a program

T ET.
LT % | E & Marne: |Burn image

|type filker text

E| Main qgh ReFresh\I 21 Envirmmenq = gommon)
B P
% rogren . —Location:
% BUrn image
% Debug mode | CAwindvRibintavarice. exe
Browse Workspace, .. | Browse File Syskem,.. | Variables, .. |
—Working Directory:
| FAworkspace_|oc: [DebugTest
Browse Workspace. .. | Erowse File Syskem. .. | Variables. .. |
—Argurents:
-2 -repf DebugTest. elf -j usb ;I
[~
Yariables. .. |
Moke: Enclose an argument conkainng spaces using double-quotes (),

Apply | Flewerk |

Filker matched 3 of 3 items

(7 Bun Close |

Figura 7: Cuadro de didlogo External Tools, Pestafia main
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& External Tools

Create, manage, and run configurations

Run a program

* iz .
BYER, | E & Marne: |Burn image
byvpe filker text
I El Iain r,néh Refresh rﬁ Environment rlj Carmman
= P
$£ image ~Save as
- il 1 imagde
i & i+ i
% Debug mode et e
"~ Shared file: I Bromse, .. |
r~Display in Favarites menu —Console Encoding
G External Tools & Dofaul (Cp1251)
' other [150-a853-1 =l
—Standard Input and Cutput
¥ allocate Consols (necessary For input)
™ File: |
Workspace,,. | File/System, .. Variables, . .
I™ Append
¥ Launch in background
Apply | Hewert |
Filker matched 3 of 3 items
@ Run Close |

Figura 8: Cuadro de didlogo External Tools, Pestafia Common

El programa ‘avarice.exe’ también necesita ser ejecutado cada vez que quiera empezar una sesién de

depuracién, asi que hay que configurar otra entrada “external tool”, llamada Debug mode (ver

Figura 7). Haga click en el boton New launch configuration de nuevo e introduzca Debug

mode en el cuadro de texto Name. Una vez mas, introduzca una nueva ruta para ‘avarice.exe’ en el

cuadro de texto Location y la ruta del proyecto actual en el cuadro de texto Working

Directory. Enelcuadrodetexto Arguments, introduzca “-2 -j usb :2525” (Fijese en el espacio

entre ‘usb’y *’), y haga click en Apply. Pulse Close para cerrar el cuadro de didlogo.
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Creando un makefile

Las herramientas de WinAVR requieren de la utilizacion del llamad makefile —un archivo de texto plano
que contiene todas las configuraciones (opciones del compilador, rutas, librerias, etc. ) requeridas para
construir la imagen objetivo. Dispone de un makefile de ejemplo que podra utilizar como referencia en
futuros proyectos.

Para afiadir un makefile a su proyecto, seleccione File ->New ->File (ver Figura5) o haga click

con el botdén derecho en la ventana del explorador de proyectos y seleccione New -> File del menu

emergente
& New File _10O| x|
File

Create a new file resource,

= |

Enter or seleck the parent folder:

| DiebugTest

th

""" 15 DebugTest

File narme: I rakefile|

Advanced == |

(7) | Firishi I Cancel

Figura 9: Cuadro de didlogo New File

Introduzca makefile en el cuadro de texto File nameyhagaclicken Finish paracerrarel cuadro
de didlogo (ver figura 9). Se creara un makefile nuevo y se abrird el editor de cédigo. Pegue el contenido
del makefile de ejemplo en el editor
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SRR i
# Makefile for the project DebugTest

FHE A A A R R R R R
## General Flags

PROJECT = DebugTest

MCU = atmegal28l

TARGET = DebugTest.elf

CC = avr—-gcc.exe

## Options common to compile, link and assembly rules
COMMON = -mmcu=$ (MCU)

## Compile options common for all C compilation units.
CFLAGS = $ (COMMON)

CFLAGS += -Wall -gdwarf-2 -0Os -std=gnu99 -fsigned-char -fpack-
struct

CFLAGS += -MD -MP -MT $ (*F).o -MF dep/$ (QF).d

## Assembly specific flags

ASMFLAGS = $ (COMMON)

ASMFLAGS += $(CFLAGS)

ASMFLAGS += -x assembler-with-cpp -Wa, -gdwarf?2

## Linker flags
LDFLAGS = $ (COMMON)
LDFLAGS += -W1l, -Map=DebugTest.map

## Intel Hex file production flags
#HEX FLASH FLAGS = -R .eeprom

HEX EEPROM FLAGS -j .eeprom
HEX EEPROM FLAGS += --set-section-flags=.eeprom="alloc,load"
HEX EEPROM FLAGS += --change-section-lma .eeprom=0

## Path to Stack, StackSupport, HAL, TOSLib.
SUPPORT DIR = $(AEZN HOME)

## Modules directories paths.

APP DIR = $(PRJ_HOME)

STACK DIR = $ (SUPPORT DIR)/Stack

STACK SUPPORT DIR = $(SUPPORTiDIR)/StaCkSupport
TOSLIB DIR = $(SUPPORT_DIR)/TOSLib

HAL DIR = $(SUPPORT DIR)/HAL/HAL R6
FRAMEWORK DIR = $(SUPPORT_DIR)/Framework
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## Include Directories.
INCLUDES = -I"S$(STACK DIR)/include" \
-I"$(TOSLIB DIR)/include" \
-I"$ (HAL DIR)/base/include™ \
-I"$ (HAL DIR)/eZeeNet/include™ \
-I"S (HAL DIR)/meshBean2/include" \
-I"S$ (STACK SUPPORT DIR)/include" \
-I"S (STACK SUPPORT DIR)/include/stack" \
-I"$ (FRAMEWORK DIR)/include"

## Library Directories
LIBDIRS = -L"$ (HAL DIR)/1lib" \
-L"$ (TOSLIB DIR)/1lib" \
—L"$(FRAMEWORK_DIR)/lib" \
—L"$(STACKisUPPORTiDIR)/lib"
## Libraries
LIBS = -1ltos \
-lmeshBean2 \
-1FW \
-1ZigBitInt \
-lstackSupport \
-lc

SRC = $(APP DIR)/DebugTest.c \
$ (STACK SUPPORT DIR)/src/ConfigServer.c \

## Objects explicitly added by the user
LINKONLYOBJECTS = $(STACK_DIR)/lib/NWKMACLibA.O \
$(STACKiDIR)/lib/APLLibA.O \
$ (HAL DIR)/lib/wdtinit.o

## Build
all: clean $(TARGET) DebugTest.hex DebugTest.eep size

## Compile
DebugTest.o: DebugTest.c
$(CC) S (INCLUDES) $(CFLAGS) -c s<

ConfigServer.o: $(STACK SUPPORT DIR)/src/ConfigServer.c
S (CC) S (INCLUDES) $(CFLAGS) -c $<

## Build

all: clean $(TARGET) $(PROJECT) .srec $(PROJECT) .hex
S (PROJECT) .eep size
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##Link
S (TARGET) :
$(CC) $(CFLAGS) $(INCLUDES) $(SRC) $(LINKONLYOBJECTS)
-0 $(TARGET) $(LIBDIRS) $(LIBS)
.srec: $(TARGET)
avr-objcopy -O srec $ (HEX FLASH FLAGS) $< $@

e

oe

.hex: $(TARGET)
avr-objcopy -O ihex $(HEX FLASH FLAGS) $< $@

%.eep: $(TARGET)
avr-objcopy $ (HEX EEPROM FLAGS) -O ihex $< $@

%.1lss: $(TARGET)
avr-objdump -h -S $< > sS@

size: S${TARGET}
@echo
Qavr-size -C —--mcu=S${MCU} ${TARGET}

## Clean target
.PHONY: clean
clean:

-rm -rf $(OBJECTS) DebugTest.elf dep/* DebugTest.hex
DebugTest.eep DebugTest.srec DebugTest.map

## Other dependencies
-include $(shell mkdir dep 2>/dev/null) $(wildcard dep/*)

## End of makefile

Anadiendo cédigo al proyecto

Puede afiadir al proyecto un archivo fuente (.C) que contenga el cddigo con el que se va a construir el
proyecto.

Seleccione File ->New ->Source file del menu de aplicacidn (ver Figura 5) o haga click con
el botdn derecho en la ventana del explorador de proyectos y seleccione New -> Source file del
menu emergente. Introduzca “DebugTest.c” en el cuadro de texto Source File y haga click
Finish enelbotdn para continuar. Tendra que especificar la extension ‘.c’ del archivo. A continuacion
se muestra el codigo de ejemplo utilizado en este ejemplo:
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/~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k****************************

LED Blinking Implementation Project: C source
*******************************************************/
#include "framework.h"

#include "gpio.h"

#include "apptimer.h"

#define LED GPIO 0 // Pin connected to LED.

// Functions' declarations.
void mainloop(); // Main loop.
void timerFired(); // Blink timer handler.

/*******************************************************

User's entry.

*******************************************************/
void fw_userEntry (FWW_ResetReason_t resetReason)
{
// Initialize the pin connected to the LED.
gpio_setConfig(LED, GPIO_OUTPUT) ;
// Open and start blink timer.
{
int handle;
handle = appTimer open (timerFired);
appTimer start (handle, TIMER REPEAT MODE, 1000);
}
// Start main loop.
fw_setUserLoop (20, mainLoop) ;

}

/*******************************************************

Main loop.
*******************************************************/
void mainLoop ()

{

// Addtional user's activities.

}

/*******************************************************

Blink timer handler.
*******************************************************/
void timerFired/()
{

static bool on = 0;

gpio_setState (LED, on);

on =on ? 0 : 1; // Toggle.
}
// eof DebugTest.c
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Utilizando variables de entorno en el makefile

Fijese en las siguientes lineas del texto makefile:

## Path to Stack, StackSupport, HAL, TOSLib.
SUPPORT DIR = $(AEZN7HOME)

## Modules directories paths.

APP DIR = $(PRJ HOME)

AEZN HOME yPRJ HOME son variables de entorno que, respectivamente, apuntan a la carpeta API

de la instalacion eZeeNet y el directorio que contiene los archivos del proyecto. Usando las variables,

puede evitar el tener que especificar las rutas directamente en el makefile y, asi, la necesidad de modificar

el makefile para cada proyecto que crea. Puede utilizar las variables en Eclipse para especificar las rutas.

1. Seleccione Project -> Properties del menu de aplicacidn o haga click derecho en el
nombre del explorador del proyecto y seleccione Properties del mend emergente.

E Properties for DebugTest

[t Filcer eeet Environment

(=T

- Rezource

|

- Bilders
Corfiguration: |Default El Mariage corfigurations

[E- CfZ4++ Build
Ciscovery opkions

- Enwirammenk
E---S:U:hg:
i Tool chain editar
" yanahies
[#l- CRC 4+ Gensral
- Projeck Referances
- Pef ackoting Histaty
RuryDebug Settings

Ervdironmert wariables ba et

* fppend wariables b native ervironment

™ Replace nathe enyironment with specdfied one

Mew...

Seleck. .

Edit. ..

Undefine

HiH

Rastare Defaaks | apply I
(7 o, | Cancel |
Figura 10: Cuadro de dialogo Propiedades
2. Hagaclick en el botén New... del cuadro de didlogo Properties (ver Figura 10). Introduzca
“AEZN_HOME” en el cuadro de texto Name y la ruta completa del directorio API de la instalacion
ZDK en el cuadro de texto Value, como se muestra en la Figura 11.
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e x|

Marre: | AEZN_HOME

Yalue: | L fzdk release)api Variabes |

(] 4 I Zarcel |

Figura 11: Cuadro de didlogo Definicidn de Variables

3. Hagaclicken OK para cerrar la ventana. Se afiadird una nueva variable a la lista.

4. Repita los mismos pasos para crear la segunda variable, PRJ HOME, con el valor ajustado al
directorio de su proyecto actual (‘c:/ezeenet/debugtest’ o similar).

5. Hagaclicken Apply vy, entonces, en OK para cerrar el cuadro de didlogo

Configurando el depurador

Seleccione Run ->Open Debug Dialog.. del menu de aplicacion. Pulse con el botdn derecho
delraténen C/C++ Local application yseleccione New del mend emergente.

En el cuadro de didlogo que aparece, siga los siguientes pasos:

1. Introduzca Debug” en el cuadro de texto Name.

2. ClickBrowse enjuntoal cuadro de texto Project, seleccione su proyecto (Debug Test) de la
listay pulse en OK.

3. Introduzca “DebugTest.elf” en el cuadro de texto C/C++ Application.

4. Pulse Apply.

5. Seleccione la pestafia Debugger.

6. Seleccione gdbserver Debugger delalista Debugger.

7. Desmarque la casilla.

8. Pulse Browse junto al cuadro de texto GDB Debugger y vaya al subdirectorio ‘bin’ del

directorio de instalacion de WinAVR. Seleccione el archivo ‘avr-gdb.exe’ y pulse Open (o
introduzca la ruta completa a ‘avr-gdb.exe’, normalmente algo como ‘C:\WinAVR\bin\avr-
gdb.exe’).

9. Limpie el cuadro de texto GDB command file.

10. Seleccione la pestafia Connection.

11. Cambie el tipo de conexién a TCP y el nimero de puerto a 2525.

12. Seleccione la pestaiia Common.

13. Pulse el item Debug enlalista Display in favourites.

14. Pulse Applyydespués Close.
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Construyendo la imagen

Una vez haya configurado todo, es hora de construir la imagen que va a ser depurada. Seleccione

Project ->Build project del ment de aplicacién. Las herramientas WinAVR se muestran en
la ventana consola en la parte inferior de la pantalla (ver Figura 12).

Programando el dispositivo con la nueva imagen construida

Una vez que la imagen se haya construido con éxito, se programa en el MeshBean a través de JTAG.

1. Conecte su dispositivo JTAG al MeshBean con el conector suministrado y al PC con el cable USB.
Alimente ambos dispositivos.

2. Ahora, seleccione Run ->External tools ->Burn image. Sitodas las conexionesy

configuraciones son correctas, comenzara la programacién del nodo con el indicador de progreso en
la ventana consola.
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Figura 12: Pantalla de Depuracion

Cuando haya finalizado, aparecerd un mensaje de error: “USB bulk read error:
usb reap async: error: A device attached to the system is not
functioning.”.Tan sélo ignérelo.

No olvide reprogramar la MeshBean cada vez que haga cambios en el cédigo y reconstruya la imagen.
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Depurando la aplicacion

Una vez que la MeshBean haya sido programada con la imagen ejecutable, se puede comenzar con la
sesién de depuracion.

1. Primero sitle un breakpoint en una de las funciones void timerFired (), (ver Figura 12).
Posicione el cursor en la segunda linea de esta funcién y seleccione Run ->Toggle
breakpoint del mend o presione Ctrl-Shift-B. La linea de marcard con un circulo a su izquierda.

2. Para comenzar la depuracidn, seleccione primero Run ->External tools ->Debug
mode. Esto provocara que su JTAGICE pase a modo depuracidn y permitira un control adicional
sobre el dispositivo objetivo. Necesita ejecutar este comando cada vez que quiera comenzar un
sesion de depuracidn. La salida de la ventana consola deberia mostrar esto:

AVaRICE version 2.6, May 15 2007 17:07:24

Defaulting JTAG bitrate to 1 MHz. Make sure that the target
frequency is at least 4 MHz or you will likely encounter
failures controlling the target.

3. Seleccione del menu de aplicacion o pulse F11. Debera aparecer la siguiente pantalla (ver Figura 13):

& Confirm Perspective Switch x|

) . This kind of lsunch is configured to open the Debug perspective when it
\___4:/ su=pends,
This Debug perspective is designed to support application debugging, It
incarpar akes views For displaying the debug stack, variables and bre akpoink
managerment .

Do wou wank ko open this perspective nowy

[ Remember mv decision

Figura 13: Confirmacion de la Perspectiva

4. Pulse Yes paracambiar la vista (o, en terminologia Eclipse, perspectiva) a modo depuracion. EL
disefio de la pantalla cambiara a algo como esto (ver Figura 14):
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Figura 14: Pantalla de perspectiva Proyecto

Puede cambiar entre perspectivas Depuracién y Proyecto utilizando los botones Debug yC/C++ enla
esquina superior derecha de la ventana Eclipse.

La ejecucidn deberia parar ahora en la linea que tiene un breakpoint. Se pueden utilizar las muchas
facilidades de depuracion de Eclipse para ver el trazado de la pila, las variables de memoria, registros y
otras muchas cosas. El mend Window ->Show view daaccesos a cualquiera de las ventanas de
depuracion.

El mend Run contiene la mayoria de las prestaciones de depuracién que necesita, como “step into”,

»ou

“step over”, “run to line” y otros.

5. Presione F8 o seleccione Run ->Resume del menu para continuar con la ejecucion
6. Seleccione Run ->Terminate para pararladepuracion.
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